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See the way Request a Quote for Magento 2 extension works.

Ultimate Guide for Magento 2 Request a
Quote

Boost sales revenue by understanding and meeting customer demand with Magento 2 Quote.
Strengthen your competitive position with the personalized purchasing offer.

e Create quotes in one click from product or category pages
Let customers request quotes for unlimited products quantity
Provide individualized pricing based on customer details
Efficiently manage all requests on a quotations grid
Negotiate over the prices in a convenient way

Convert Magento 2 quotes into orders in a few simple steps
Hide prices for specific products or whole categories

General Settings

To configure general settings, go to Stores - Configuration - Amasty Extensions » Request a
Quote.

General Tab

The extension allows to choose specific customer groups that will be able to request quotes and
create them from product or category pages. It also allows to disable quotation for specific product
categories.
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General
Enable'Request_a_g.l_.m'_ce_' Yes

'‘Add to Quote' button on Product

N Page Show -
'Add te Quote’ button on Category Show .
Disable Quotation for Ca'_c_e_g::-ri_e; . Gear a P
......Bags

.. .. .. Fitness Equipment

vew . Watches
... Training T
. ) P
‘Add to Quote’ button will be hidden for each product from the selected
categories. This setting is applied to product list and product page.
Allow Quote Request for
l_ Mot Logged In
Customer Groups
e General
Wholesale
Retailer
&
f'Mot Logged In' option is chosen, guest users will insert email addresses

upon gquote SUDMIsson and aocounts will be created automatical -

Enable ‘Request a Quote’ - set to Yes to enable the extension.

‘Add to Quote’ button on Product Page - Show ‘Add to Quote’ button if you want your customers
to be able to add products to quote cart right from the product page. If not, Hide the button.

‘Add to Quote’ button on Category Page - Show ‘Add to Quote’ button if you want to let your
customers add products to quote requests from the category page. If not, Hide the button.

Disable Quotation for Categories - specify product categories for which quote requests will be
disabled. 'Add to Quote' button will be hidden for each product from the selected categories.

Allow Quote Request for Customer Groups - specify the customer groups to allow quote
requests.

If ‘Not Logged In' option is chosen, guest users will insert email addresses upon quote submission
and accounts will be created automatically.

Note, that all necessary for registration fields from the Stores - Configuration - Customers -
Customer Configuration - Name and Address Options will also be shown on the quote cart for
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unregistered users. This way, all the customer information will be collected.

Also, if you are using Magento Commerce, you can create additional Customer Attributes (Stores -
Attributes —» Customer) for unregistered users, which will be displayed in the quote request form and
will be saved in a Customer Account.

© Luma

What's New Women

Men Gear Training

Quote Cart

Item

Montana Wind Jacket
Size: L
Color: Red

Iwould also buy a yellow jacket,
the same size

Taurus Elements Shell

Size: 5

Color: Yellow

Do you have the size L ?

Price Qty
$| 45.00 1
$| 62.00 1

Clear Quote

Search entire store here...

Subtotal

$45.00

B

$62.00

#

[}

Update Quote

iy 2
Q uote Summa Yy
Subtota $107.00
Tax $0.00
Quote Total $107.00

Enter your details
Email Address *

veronica@example.com

Remarks

I'd buy these products if you could
give me a discount.

First Name *
Veronica
Last Name *

Harris

Submit Quote

If ‘'Not Logged In' option is not chosen you will be proposed to fill in the following fields:
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Allow Quote Request for Customer
Q 4 Mot Logged In

Group

[store view] General
Wholasale
Retailer

If 'Mot Logged In' option is chosen, guest users wi
insert email addresses upon quate submission and
accounts will be created automatically.

Inform Guests Yes

sbore view)

5how ‘Login for quote’ button for guests

Button Text

[store view]

Login for quots

In such a case, guest visitors will be asked to log in to add products to quote.
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Q LU MA Search entire store here... \E

What's New Women Men Gear Training Sale

Home > Men > Tops » Hoodies&5Sweatshirts > Ajax Full-Zip Sweatshirt

Ajax Full-Zip
Sweatshirt

Ee the first to review this product

$69.00 e

Size
x5 5 M L AL

Color Elue

Qty
]

Add to Cart Login for quote

(1] 1,

Allow to change Price in Quote Cart
[website]

Yes -

Set 'Mo' to disable price changing for customers in Quote
Cart. Automatic quote approval will be disabled as well.
Motel If Amasty Hide Price is enabled, the quote will be
submitted with O price. Please make sure to check the
quote before approving,

Allow to change Price in Quote Cart - set 'No' to disable price changing for customers in Quote
Cart. Automatic quote approval will be disabled as well. The feature is useful in case a customer
wants to ask for a duscount and get a quote for Magento 2 order, but doesn't know exactly what price
to set.

If Amasty Hide Price is enabled, a customer will see the price as N/A. In the admin panel, the quote
will be submitted with 0 price. Please make sure to check the quote before approving.
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Approve Quotes Automatically |, -
Set Yes' to approve quote automatically if the overall discount
= less thian certain % amount

if Quote Discount is Less than (%) 10

The discount is calculated for the entire quote (not for separate
products). Mate: discount calculation is based on prices
excluding tax.

Cost Atm_b"!te cost a

- Empty --
cost

msrp

prica
special_price
tier_price
weight

Approve Quotes Automatically - this option allows you to approve quotes automatically if the
discount of the submitted quote is less than the specified percentage amount.

if Quote Discount is Less than (%) - specify the discount percentage amount for automatic quotes
approving. The discount is calculated for the entire quote (not for separate products). Note: discount
calculation is based on prices excluding tax.

Cost Attribute - choose which attribute will be used as ‘Cost’ attribute. This option will make the
decision-making process easier (whether approve or not the quote), because admin will see the
difference between requested price and product’s cost.

Expiration & Reminder Tab

The extension allows to set default expiration period for quote requests.
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Expiration & Reminder

Quote EJ:{_F:II! r.fm?.r_u 10

Set default period in days for quote to be valid once
approved. For zero and higher this value can be set for
each quote individually. Keep empty to disable this
feature.

Send Reminder Email aﬁ?r' Day(s) |

2

Set default period in days to send reminder once quote
approved. For zero and higher this value can be set for
each quote individually. Keep empty to disable
reminder.

Quote Expiration - Set default period in days for quote to be valid once approved. For zero and
higher this value can be set for each quote individually. Keep empty to disable Magento quote
lifetime.

Send Reminder Email after Day(s) - Set default period in days to send reminder once quote
approved. For zero and higher this value can be set for each quote individually. Keep empty to disable
reminder.

Admin Notifications

With the extension it is possible to configure different notification emails. Admin will get email reports
with new quote requests.
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Admin Notifications

Send Email Reports for New Quote ]
EE equests Yas{customize) -
Stare view] Yes{customize)

Yes{instantly)
Mo

Freaensy  [oay -
Weekly
Maonthly

StartTime |53 | o lilso0 | » [:lo0 | w

BloDa

Admin Email_ﬁ.ddres.s_.

e e

admin@example.com

Input an email address, the extension will send
notifications to.

Admin Motifications (Default) -

Select the appropriate template for the ema
notifications.

General Contact -

Send Email Reports for New Quote Requests - Choose the option to enable emails to admin with
the quote requests that have been recently created or updated. You can notify your admins instantly
or set a custom notification schedule.

Frequency - If a custom option is chosen, set the necessary frequency: notify admins Daily, Weekly
or Monthly.

Start Time - customize the particular time for notifications.
Admin Email Address - Input an email address, the extension will send notifications to.
Email Template to Notify Admin - Select the appropriate template for the email notifications.

Email Sender - specify your company’s email from which the notifications will be sent.
Customer Notifications

Customers will get notifications when their quotes are created, modified, accepted or expired. Also
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choose Email Templates to notify you customers that their quote has been Submitted, Approved,
Modified, Cancelled or Expired.

Customer Motifications

Email Sender

General Contact -

Email Template for Sme'tt?ﬁ _*?_E_L'F:F? Submitted Quote Customer Motification( | =

Email Template for Approved Quote

Approved Quote Customer MNotification ([ | =

Email Template for Modified Quote

Modified Quote Customer Motification (O | =

Email Template for Cancelt—;-_{% _{_:_'_'_“':_:t_E.' Canceled Quote Customer Motification(C | =

Email Template for Expired Quote

Expirad Quote Customer MNotification (De A

4

Email Template for Remlnder Reminder Quote Customer Motification (I

To create templates, go to Stores » Marketing - Communications -» Email Templates.

PDF

The quotes can be downloaded in PDF format both from backend and frontend. In addition, you can
automatically attach PDF to the Approved Quote customer notification and configure PDF content
according to your needs on the store view level.
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by

PDF o)

Tao use PDF functionality, please install the library dompdf/dompdf. To da this, run the command "compaser require
dompdf/dompdf" in the main site folder.

Automatically Attach PDF File to

N =2 -
Approved Quote Notification N
Template Content 2l @vars { 7]
' "var customer_telephone | raw":"Customer's
phone number”
"war shipping_te I phone | raw™"Shipping

phone number'

"var store_phone | raw":"Store phone
number

"var quote_expiry_date | raw":"Date o
quote has expired”

"war shipping_method |raw""Shipping
method"

"var has_shipping_info| raw™:"Has Shipping

[=1)

-

<IDOCTYPE html PUBLIC "-/"W3C/HDTD
KHTRIL | 0 5tr -:" EM"

"httpuffanaw w3 org TRxhtmI1/DTD xhtml1-
strict.dtd”:
<html - . P

-

To use PDF functionality, please install the library dompdf/dompdf. To do this, run the command
“composer require dompdf/dompdf” in the main site folder.

composer require dompd

Uq1ng version for

Installing (8.3.0): Downloading (100%
Installing ( 3.3): Downloading ( %

Installing 5.1): Downloading (

Installing (v0.8.3): Downloading (1t
dompdf /dompdf suggests installing ext-gmagick (Improves image processing perform
ance)

Package phpunit/phpunit-mock-objects is abandoned, you should avoid using it. No
replacement was suggested.

Quote Requests Management

From the admin panel your can see and manage all the request quotes in a convenient grid,
accept/reject a quote or suggest a new best-suited price.

Go to Stores - Sales - Amasty Request a Quote - Quotes.
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QUDtES J_ demouser «
Create New Quote
Y Filters > DefaultView = £ Columns * X Export v
Actions | 7 records found (2 20 ¥ | per page 1 of 1
selected)
Cancel /
Close
Purchase Purchase
Approve Point Date Statuis

1000000016 Kain Webzite Apr15, 2015 Expired $4330 %4330 View 2019-04-23
Main 91017 AM 00:00-00
Website S5tore
Default

Store View

1000000012 Main Website Apr13, 2019 Expired $81.19 .« $81.19 View 2019-04-25
Main 9:04:18 AM 09:05:08
Website Store
Default

Store View

o 1000000007 © Main Website Mar 4, 2019 Complete . $30.00 « $30.00 View A
Wain 10:52:45 AM
Website Store
Default

Store View

W 1000000005 Main Website Mar 4, 2019 Canceled $2165 « $2165 View MIA
WMain 10:44:21 AM
Website Store
Default

Store View

You can see the ID of the quotes, their Purchase point, Purchase Date, Status and Grand Totals.

To Approve or Cancel/Close several quotes in one click, tick them and choose the necessary action in
the Actions dropdown menu.

Click View to see detailed information about quote requests. You can Edit and Approve the quotes
with Pending status.

Click Create New Quote to create a quote on behalf of customer. After approving a quote it will be
visible at customer account page, in 'My Quotes' section.
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Usage Example

To manage all the quotes properly, let’s consider an example of a particular quote management from
the very beginning.

Step 1. Creating a Quote by a Customer

First, your customers create quotes from the product or category pages via Add to Quote button.

==x  BS  Jtems 1-9 of 14

4
. _f [
N e —
Breathe-Easy Tank Antonia Racer Tank WMaya Tunic
L& 8.6 2 reviews ¥ 3 reviews RN W 0 1 review
$34.00 $34.00 $29.00
x5 5 M L K5 5 M L X5 - M L
XL XL XL

¥ .I
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The module allows displaying 'Add To Quote' button for custom product types.

Also, customers can move items to quote straight from their Shopping Cart via 'Request a Quote'
button.

LUMA Search entire store here... FA =0
O

What's New Women Men Gear Training Sale

Shopplr‘lg Cart summary

Estimate Shipping bl
and Tax
Item Price Oty Subtotal
Subtotal $22.00
Q Radiant Tee %$22.00 1 £22.00 Tax $1.82
Size: S Order Total %23.82
LN Color: Orange
’ Proceed to
Checkout
Maue to st 4 m Check Out with Multiple
Addresses
Update Shopping Cart
Request a
Apply Discount Code Quote

Then they go to their Quote Carts to view and edit their quote requests.
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Q L U M A Search entire store here... lE[ .?F

X

2 Items in Cart Cart Subtotal :

$73.00

Home » Women » Tops » Bras&Tanks > Al MYQI.ID'EECEIT
itﬁl'

=
o
/

What's New Women IMen Gear

Lean Yoga Top

See Details «
$39.00

Qty: 1 rd

=] 1

Antonia Racer Tank

See Details «
$34.00

Qty: 1 rd

Add to Cart ‘ Add to Quote

Magento 2 Quote Extension allows your customers request a quote for unlimited products quantity.

=] 1

There customers specify the price they want to request, items quantity, add some notes that describe
their requests in the Remarks field and Submit Quote.

If you allowed 'Not Logged In' users to create quotes, they will have to provide additional details
before quote submission:
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Search entire store here...

What's New Women Men Gear Training Sale
Quote Cart Quote Summary
Subtotal $77.00
Item Price Qty Subtotal Tax $0.00
Olivia1/4  §| 70.00 3 | $77.00 Quote Total $77.00
Zip Light Excl. Ta
Jacket Enter your details
. e S Email Address =
Color: Blue
Add Note guest_user@example.com
Remarks
£ 10
I'll buy 3 itemns at once if you could
T Update Quote reduce the price to 70%. Thanks!

First Name *

Peter

Last Name #*

Erown

Submit Quote

Online buyers are also able to Add Notes per item, Clear Quotes and Update Quotes right from

the cart.

amasty
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© Luma FE =

What's Mew Women Men Gear Training Sale

Quote Cart

Item Price Oty Subtotal Quote
Summary
Antonia Racer $ | 30.00 3 $34.00
Tank Excl. Ta Subtotal $73.00
Size: 5 Tax $6.02

Color: Black

Quote Total $79.02

Please, send me
your size chart in

PDF format, if Enter your
ossible. .
g details
i
Remarks
rd l]ﬂ]]' I'll purchase 3 Antonia

Racer Tanks and 5
Leah Yoga Tops if you
Leah Yoga Top $| 30.00 5 $39.00 give it prices of 305 for
F—— each item.
Size: M N £
Color: Purple

Add Mo .
= Submit Quote

&

N
m

Clear Quote Update Quote

Magento 2 Quote Extension allows shoppers to request quotes for Simple, Configurable,
Downloadable, Virtual, Grouped and Bundle product types.

If a customer edits products in a Quote Cart, previous items are removed and replaced with the new
ones together with new values. Thus, keep in mind, that the previous custom price is not saved.

Step 2. Managing a Quote from the Admin Panel

When the quote has been submitted, you will immediately see it on the grid with the Pending status.
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QUDtES XY demouser ~
W Filters > DefaultView » £ Columns oty Export v
Actio..| = & records found 20 ¥ | per page 1 of 1

Purchase Point | PurchaseDate T | Status

1000000012 Main Website Mar 11, 2019 Pending = $259.80 = $250.80
Main Website 11:42:35 AM
Stare
Default
Store View

Click View to see the detailed quote information. You can Approve, Edit the quote or Download PDF
copy of it.
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#1000000024

< Back

Cancel / Close

Approve

Download PDF m

Quote & Account Information

Quote # 1000000024

Quote Date
Quote Date (UTC)
Status

Created From

Sep 5, 2019, 1:15:39 PM

Sep 5, 2019, 1:14:04 PM

Main Website

Account Information Edit Customer

Customer Mame Veronica Costello

Email roni_cost@example.com

Pending Customer Group zeneral

Account Created Mar 11, 2018, 4:24:23 PM

Main Website Store

Default Store View Orders Tota $76.03
Placed from IP 213.184.226.82
Product Cost Product Price (Excl. Tax) Quote Price Qty Row Total
Maya Tunic $20.00 $29.00 $23.00 1 $23.00
SKU: WTO7-5-Yellow
Mora Practice Tank $23.00 $39.00 $30.00 1 $30.00
SKEU: WTO3-M-Purple
Quote Total
Remarks for this Quote Quote Totals
Subtotal $53.00
Grand Total $57.37

Here all the information about the customer and the quote request is displayed.

Product Price displays a real price at the store. Customer’s request is shown in the Price column.
Row Total is also displayed according to customer’s price.

Also, it is possible to request quotes for products with tier pricing. In this case, the extension takes
tier pricing into account and automatically offers best price for your customers. If a user wants to
quote for a lower price, you can check the Tier Price and the suggested by a customer price in one
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place.

Quote Items

Product Cost Price (Excl. Tax) Qty
affirm Water Bottle $7.00 $£7.00 0
SKU: 24-UG06 Tier Pricing
10 for $5.00
3.00

Total 1 product(s) Subtotal: £30.00
Additional Additional

) 0.00 ) 0.00
Discount (%) surcharge (%)

View the information about a customer and easily evaluate when the account was created and how
much has the customer spent during that time.

Hit the Approve button if the quote terms are satisfactory for you. You can also Edit the quote if
needed.
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Edit Quote

Quote & Account Information

Quote # 1000000024

Quote Date Sep 5, 2019, 1:14:04 PM
Status Approved
B Mon, 16 Sep 20° [

Account Information Edit Customer

Customer Mame
Emai
Customer Group

Account Created

Veronica Costello

roni_cost@example.com

General

Mar 11, 2018, 4:24:23 PM

Reminder Date

Wed, 11 5ep 20°

Orders Total 576.03
Created From Main Website
Main Website Store
Drefault Store View
Quote Items Add Products
Row
Product Cost Price (Excl. Tax) Quy Subtotal Subtotal Action
Maya Tunic $29.00  $29.00 E E{:.I.ST:x: E)E I.ST:x:
SKU: WTDT-S- 2185 - -
Yellow Incl. Tax: Incl. Tax:
$23.65 $2365
Neora Practice $39.00 £39.00 Excl. Tax: Excl. Tax:
Tank E $28.50 $28.50 Please scle 8
28.50
SKU: WTO3-M- Incl. Tax: Incl. Tax:
Purple $30.85 $30.85
Total 2 Subtotal: £50.35 £50.35
product(s)

Remove discount

Applied discount: 5%

Additicnal
Discount (%)

Additional
Surcharge (%)

Quote Total

Remarks for this Quote

Quote Totals

Update ltems and Quantities

Remarks
Subtotal 33035
Hi Veronica, we can offer you a 5% discount.
Shipping & Handling $0.00
Tax $4.15
Grand Total 554.50
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Note, that you can set the Expiry and Reminder date only after the quote was Approved. Other
options can be edited either before you approve the quote or after that.

Edit products’ Price and Quantity in the appropriate fields, set Expiry and Reminder date, leave
Remarks.

Apply Additional Discount/Surcharge to the quote. Insert a percent number of discount/surcharge
and it will be applied to the whole quote.

If you don’t want to offer a special price for some particular product, remove it in one click via Action
dropdown menu.

To edit products’ size and color, press the Configure button.

Configure Product X

Associated Products

Size

28 r
Color

Purple -

Quantity 3

With the extension you are also able to add products to your customers’ quotes. Click Add Products.

Choose the products to add. The configuration field where you can specify the size, color and quantity
will be displayed automatically.
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Please select products Add Selected Produci(s) to Quote
m Reset Filter 2045 records found

20 ¥ | per page 1 of 103 >
D T | Product SKU Price Select Quantity
From Any |¥
To
2046 Configure Set of Sprite 24-
Yoga Straps WGOB5_Group
2045 Configure Erika W5H12 45.00 -
: « 3
Running Short
2044 Erika Running Short-32- . WSH12-32-Red 545.00

Red

Click Add Selected Product(s) to Quote.

Check in advance on a Product Page that added items have Inventory Source specified for
selected store view. If Inventory Source is not specified, the product cannot be displayed at the
storefront, and it will also be impossible to create a quote both as customer and admin.

Click Update Items and Quantities to preview all the products and the subtotal of the quote.
Provide a Note for the Quote to give a customer important or additional information about your offer.

In addition to this, it is possible to set custom shipping addresses, methods and custom fees right
from the editing page. To do this, tick the Configure Shipping hitbox.

Configure Shipping

Quote Total

Remarks for this Quote

Remarks
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In the Address Information tab you can select one of the existing billing or shipping addresses or
create new ones. Also, edit any customer info if needed.

Address Information

Billing Address Shipping Address

¥| Same As Billing Address
Select from existing customer addresses:

Select from existing customer addresses:
Add New Address v

Add New Address
Veronica Costello, 6146 Honey Bluff Parkway, Calder, Michigan 49628-7978, United States

Mame Prefix

+ First Name
#+ First Name

Veronica

Middle Name/Initial _ o
Middle Mame/lInitial

Proceed to the Shipping Information section.

Shipping Information

Shipping Method *
Flat Rate
Fixed - $10.00

Best Way
Table Rate - $10.00

| Custom

Custom Fee- %| 12.00

¥| Chosen Shipping Address and Method are allowed to be modified on checkout
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Here you can select one of the preconfigured shipping methods or set a custom fee for delivery. Allow
or disallow chosen Shipping Address and Method to be modified on checkout.

Save Quote and then Approve it.

After the approval, you are able to convert a quote to order without leaving the page.

#1000000012

v You approved the quote.

QUOTE VIEW

Information

Cancel / Close

Quote & Account Informatior

Quote # 1000000012

Quote Date Mar 11, 2019, 11:42:35

AM
Status Approved
Created Main Website
From Main Website Store

Default Store View

Placed from

P

213.184.226.82

Step 3. Quote Confirmation

Customer
Name

Email

Customer

Lroup

1 demouser -

Convert To Order Download PDF m

Account Information
Edit Customer

Veronica Costello

]
(=]
A
L
cu
3
i}
T
(=]

Customers can easily track and manage quote requests in their accounts. In My Quotes tab the ID,
Date, Quote Total, Status and Expiry Date for each quote will be displayed.
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My Quotes

Quote # Date Quote Total  Status Expiry Date  Action

1000000022 872819 $64.95 Approved Sep 7, 2019 View Mowve to Cart
1000000016 41519 $43.30 Expired Apr 23, 2019 View

1000000012 41319 $81.19 Expirad Apr 25, 2019 View

1000000011 3419 $281.19 Expirad Apr 28,2019 View

1000000005 37419 $21.65 Canceled MNAA View

1000000004 3419 $641,95 Canceled MNAA, View

6 Itemis) Show | 10~  per page

If a quote is approved by the admin, the customer can Move to Cart all the products right from the
grid.

Customers can also View Quotes details and Download PDF version of quotes.
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Quote # 1000000028 | eexe

Creation Date: September 5, 2019

20 23-3E

Expiry Date: September 15, 2019 at 1:42:35 PM UTC

Download PDF

Product Mame SKU original Price Requested Price Approved Price Qty Discount Amount  Subtotal
Bolo Sport 24- 549.00 $38.00 541.16 1 57.84(16.00%) 541.16
Watch et

Cruise Dua 24- 555.00 £47.00 545.02 1 $6.98 (12.69%) S54B8.02

-":'-.I".alcg'-_m;:c,l MGIS

Subtota £89.18

Shipping & Handling 50.00
Tax 57.36

Grand Tata £06.54

Administrator Remarks:

Additional Discount in amount of 2% was applied.

If the suggested terms of the quote are not acceptable, the customer can Cancel the request.

In case the offered prices are satisfactory, the customer is able to Move to Shopping Cart or
directly Move to Checkout all products with the custom prices in one click.

Customers are not allowed to edit the quotes with Approved status.

You will see the Complete or Canceled Status on the grid in your admin panel.

Creating a Quote by Admin

Store admin can create a quote from the Quotes grid, using the Create New Quote button.
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Quotes
Create New Quote
W Filters > DefaultView - £ Columns o, Erport v
ctions v 12 records found 20 ¥ | perpage 1 of 1
[ || ‘ 1] | Purchase Point ‘ Purchase Date t ‘ Status ‘ Grand Total | Action = Expiry Date
1000000035 | Main Website Apr 1, 2020 9:28:20 AM Pending $30.00 Wiew A
Main Website Store
Default Store View
1000000028 = Main Website Sep 5, 2019 1:41352 P Approved @ $96.54 View 20190515 134235

Main Website Store
Default Store View

Choose a customer from the grid or create a new one using the button.

Edit Quote #0000000055

& Back

Flease select a3 customer Create New Customer
m Reset Filter 5 records found 20 » | perpage < 1 of 1 2

ZIP/Post
Code

State/Province

All Countries |

3 Anna White anna@example.com [S895) 2365-8965 | United States MNew York Default
2359-5689 Store
View

2 John Harris john@example.com (2385) 2365-5698 | United Kingdom Default
2563-5698 Store
View

Veronica roni_cost@example.com (555) 229- 49628- United States Michigan Default
Costello 3326 T97R Store
View
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Select the necessary store for order to create.

Edit Quote #0000000057

Cancel

Please select a store

Main Website 9

Main Website Store

Main Website Store Default Store View

French Website

French Store

French Store French Store View

It's possible to create quote in admin panel for a customer from any store view (even if he/she doesn't
belong to the corresponding website). The customer will be duplicated to the necessary store.
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Edit Quote # A demouser

Cancel Submit Quote
Quote Currency:

IS Dollar
Js Bollar T Product Price Qty Subtotal Row Subtotal Action

Mo ordered items

Account Information
* Group * Email

Genera - eva_green@example.com
* Tax/VAT Number

5589847

MName Prefix

* First Name

va

On this step you can add product to quote, adjust prices add edit the necessary customer info.
Also, admin users can create quote themselves right from the orders grid.
To do this, go to Admin Panel - Sales - Orders.

Choose the order and click Select button in the Actions column. Clone as Quote option will appear.
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Or’dEFS j_ demouser «
Create New Order
Search by keyword Q Y Filters > DefaultView ~ -ﬂ- Columns = o Export v
Actions e 3 records found 20 ¥ | per page 1 of 1

Signifyd
' Grand Total Status Guarantee

Decision

Purchase Purchase

Point Date {Purchased)

000000003 Main Mar 4, 2019 €30.00 £30.00 Pending Select &
Website 11:07:31 AM
Main View
Website
Store Clone as Quote
Default

Store View

000000002 © Main Mar 11, 201£ £39.64 £30.64 Closed Select -
Website :24:43 PM
bain
Website
Store
Default
Store View

Now it is possible to edit the price and the quantity.
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Product Price (Excl. Tax) Qty Subtotal Row Subtotal Action

Iris Workout Top $29.00 1 £27.55 §27.55 Pleace sale

w*| Customn Price®

-
SKLU: W503-X5-Red

27.55
Configure

Total 1 product(s) Subtotal: €27.55 £27.55

* - Enter custom price excluding tax

Applied discount: 5% Remove discount
Additional Additional ..
5.00 Update ltems and Quantities
Discount (%) N Surcharge (%)

Hide Price

Magento 2 Request a Quote extension is preintegrated with Hide Price package. It provides you with
the capability to use all Hide Price benefits according to your needs: disable ordering, hide prices for
particular products or customer groups, etc. which will bring even more involving of potential buyers
into pricing negotiations.

Desite Fitness Tee Messenger Bag Oslo Trek Hoodie Aim Analog Watch
$24.00 $40.00

Add To Quote l l Add To Quote ‘ [ Add To Quote l [ Add To Quote l

General Settings
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To configure Hide Price settings go to Stores - Configuration - Amasty Extensions - Hide
Price:

To run the module on Magento 2.3, Zend DOM package should be installed. Please, run the following
command in the SSH: composer require zendframework/zend-dom

General Settings
Enable Extension | ye .

Choose “Yes" to hide the price for the selected product

categores and customer Eroups

Hide Price for Selected GrDLIPESJ NOME
NOT LOGGED IM
General
Wholesale

Retailer

Product price will be hidden for the selected customer
groups only

Hide Price for Selected Category(s) | . quEe
Root Catalog

Default Category

Gear

Bags

Fitness Equipment
Watches

Collections

Mew Luma Yoga Collection

Training

Enable Extension - set the option to 'Yes' to activate the extension.

Hide Price for Selected Group(s) - select a customer group (groups) for which the prices in
selected above categories will be hidden.

Hide Price for Selected Category(s) - select a category (categories) in which all product prices will
be hidden.

IMPORTANT: If you don't want to hide prices for whole categories you can easily hide them for
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specific products. Simply open the necessary product page here Products —» Catalog and disable
price visibility. Here you can also specify a customer group for which the product price won't be
available.

Hide Price

Display Price Mode Hide

[store view]

-- Default Config -

Show

Use Current Price Mode By Customer NOME
Group
[store view] MNOT LOGGED IM

General

Wholesale

Retailer

A

If you hide prices for whole product categories and customer groups, you can exclude specific
products and customers from the price display limitation.

Do not Apply to Product ID's |12
[store view]
Specify comma separated product id's to show the
price for. This setting has the maximum priority

Do not Apply to Customer ID's  |1134, 1116

[store view]
Specify comma separated customer id’s to show
price for. This setting has the maximum priority
Email Sender for Admin Repl:_n,r General Contact v
Email
[store view]

Email Template for Admin Reply | Amasty Hide Price Auto Reply (Defat | =

Email

[store view] EMail template chosen based on theme fallback

when "Default” option is selected
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Don't Apply to Product ID's - specify product ID's to which price display limitations won't be
applied.

Don't Apply to Customer ID's - specify customer ID's to which price display limitations won't be
applied.

The following email settings will be used when a store administrator replies to a customer quote
request via email.

Email Sender for Admin Reply - select a sender contact for store admin notifications.

Email Template for Admin Reply - select an email template for admin notifications.

Hide Price Options

H-I.{.lfe_P e | ves -
Hide "Add to Far_’t_ vas .
Hide ‘Add to Cart’ or replace it with the custom
button, £.g. 'Sign up’ or ‘Geta Quote’
Hide "Add to W..f.'u.'|.5P_1I|§t. Ves .

Hide wishiist link when orice is hidden
Hide "Add to Compare” | .
o Hide compare link when price is hidden

If the price is configured to be hidden, the customer will not see this price in quote cart as well.
Hide Price - enable the option to hide prices for selected products or product categories.
Hide Add to Cart - set the option to 'Yes' to remove the “Add to Cart” button.

Hide Add to Wishlist - This setting lets you hide/display the “Add to Wishlist” option.

Hide Add to Compare - Enable/disable adding products to the comparison.

You can let shoppers add products to wishlists and compare even when their price is hidden.

Frontend Options
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Frontend Options

Hide Price Text |Contactus

s

Dizplay the above text when price is hidden, e.g. "Call for
Price’

Custom CSS Styles for Hide Price Link | font-size: 16px;background: #eeeeee; display:
[storeview] | inline-block;border: 1px solid #cccceg;
color: #333333;cursor:
peointer;display: inline-block;padding: 7px
15px;fc nt-size: 1.4rem;
line-height: 1.Arem: P

Customize the 55 Styles for the Hide Price Link

Upload Image | Choose File | No file chosen

Show the uploaded image instead of price

Link Url | AmastyHidePricePopup

Use text ‘AmastyHidePricePopup’ for opening Ajax Popup
with a ‘Get a Quote’ form. Insert the page URL to redirect
Customers to any page you need

Hide Price Text - specify a custom text that will be used for a custom button instead of the “Add to
Cart” option.

Custom CSS Styles for “Hide Price Link” - you can customize the button display (which is used
instead of “Add to Cart”).

Upload an Image - upload any image you need to show it instead of a price.

Link URL - by default we've already specified a “Get a Quote” form code here (once a customer
clicks on a custom button the form will be shown), but you can insert any link you need to redirect
customers to the necessary store page.

Below you'll see the example of a 'Hide Price' popup.
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Juote for Driven Backpack
Customer Mame #*
Veronica Costello

Customer Email *

roni_cost@example.com

Phone Number *

14194220787

Comment

Hi, could you please tell me Driven Backpack price? I'd buy 5 of them if the
price is not higher than $&5.

Add Magento 2 Custom Form to create custom quote request forms of various types, specifying
additional information you need to generate a special price offering. Use a handy constructor to
generate multiple forms in no time and customize each form to meet your needs.

amasty


https://amasty.com

Last update: 2021/03/23 10:38

magento_2:request_a_quote https://stg.amasty.net/docs/doku.php?id=magento_2:request_a_quote

0 L U MA Search entire store here... Q E \ﬂ'
What's New Women Men Gear Training Sale Full name #
Kate Whiterhall
Email *

kate green@example.com

Phone Number *

5680

o

Bolo Sport’
Request Type *
Ak 3 Reviews
Type 3 A
Contact us
Best Time to Contact *
{‘j 1 01:50 PM
sign up Message
w what other watch
brands do you have. Please call me.

W ADD TO WISH LIST dn

Attach a document

Choose File

Admin Email Notifications

The module lets you notify admin users about new 'Get a Quote' requests via email.

Admin Email Notifications

Send Email to
[store view]

admin@example.com

Leave Empty to Disable Notifications

Email Sender | General Contact v

[store view]

Email Template
[store view]

Amasty Hide Price Admin Notificatio | =

Email template chosen based on theme fallback
when "Default” option is selected

Send Email to - specify an email address to which a new quote request notification will be sent.
Leave Empty to Disable Notifications.
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Email Sender - select an email sender contact.

Email Template - select an email template that will be used for admin user notifications.

Auto Reply Email Options

Use auto replies to quote requests to inform customers that their request is delivered and is being
processed.

Auto Reply Email Options

Enable | Yes v
Email Sender | General Contact v

Email Template | Amasty Hide Price Auto Reply (Defat | =

Email template chosen based on theme fallback
when "Default” option is selected

Enable - set to 'Yes' to activate the Auto reply option.
Email Sender - select an email contact from which auto replies will be sent.
Email Template - select an email template that will be used for auto replies.

Please view Magento 2 Hide Price User Guide for more options

Compatibility with AJAX Shopping Cart

The extension is fully compatible with AJAX Shopping Cart.

Employ Magento 2 AJAX Shopping Cart to add more advanced options to your Request a Quote
extension. For example:

e Show confirmation pop-up with the product info
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Eos V-Neck Hoodie

has been added to your quote cart

There are 4 items in your quote cart.

. Cart Subtotal: $277.00 . .
Circe Hooded Ice Fleece Eos ¥ Ariel Roll Sleeve Sweatshirt

568.00 5540

X5 5 M L XL X5 [Jﬁ 5 M L XL

L

£39.00

e Enable flying effect for add to the quote process to engage customers even more

Q LU MA Search entire store here... 1& —\U% "’EE;'

Women Men Gear Training Sale

en » Tops » Jackess »  InezFull Zip Jacket

-ull Zip Jacket

3 Reviews Add Your Review
J IN STOCK
SKU#: W07
M L XL

)

W ADD TO WISH LIST Ii ADD TO COMPARE B EMAIL

e Let customers specify the options of the simple products right in a dialog window
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Flease choose the options for your item

Proteus Fitness Jackshirt

$45.00

Size

Color

Proteus Fitness Qty “ined
oo

s o
N .

Continue shopping Add to quote

e Show related products or cross-sells in the confirmation pop-up
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£ Stor= here =

oty
Sort By | Position T 3
aboiak 3159508
) .--::i-: }—“l‘
Jupiter All-'Weather Trainer Typhon Performance Fleecelined ’;
dr 3 3 . Jacket
e 350.00
EI - - $19.00 16.00

[ I:l [ B N A s Cart aied o Cawrt:

Cron Tasks List

Magento 2 Request a Quote extension is preintegrated with Cron Tasks List to provide store owners
with an opportunity to track and manage all cron tasks running in the website background.

To view all scheduled and executed cron tasks, go to System - Cron Tasks List

Run all cron tasks and generate their schedule by clicking the ‘Run Cron’ button. Also you can delete
separate tasks in bulk, apply filtering and sorting options when it is needed.
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Cron Tasks List

o Last Cron Activity: 20 seconds ago

Y Filters € DefauliView ~ £ Columns «
Actions v 652 records found 20 ¥ perpage 1 of 33 >
g 0 Jeb Code Status | | Created At Scheduled At Executed At Finished At
038  sales_grid_order_shipment SUCCESS Mar 18, 2019 5:47:11 AM - Mar 18 2019 5:47:00 AM ~ Mar 18 2019 5:47:20 AM = Mar 18, 2019 5:47:20 AM
1058  sales_grid_creditmemao_asymnc Mar 18, 2019 5:47:11 AM | Mar 18, 2019 5:47:00 AM ~ Mar 18, 2019 2:47:20 AM - Mar 18, 2019 5:47:20 AM
1078  sales_send_order_emails SUCCESS Mar 18, 20195:47:11 AM . Mar 18, 2019 5:47:00 AM ~ Mar 18, 2019 5:47:20 AM - Mar 18, 2019 5:47:20 AM
1098  sales_order_imvoice_emails SUCCESS Mar 18, 2019 5:47:11 AM - Mar 18, 2019 5:47:00 AM  Mar 18 2019 5:47.20 AM = Mar 18, 2019 5:47:20 AM
1118  sales_send_order_shipment SUCCESS Mar 18, 2019 5:47:11 AM | Mar 18, 2019 5:47:00 AM ~ Mar 18, 2019 34720 AM - Mar 18, 2019 5:47:20 AM
1196 = indexer_reindex_all_imvalid Mar 18, 2019 5:47:13 AM ~ Mar 18, 2019 5:47:00 AM  Mar 18 2019 5:47:21 AM ~ Mar 18, 2012 5:47:21 AM
1200  indexer_update_all_views [ MISSED Mar 18, 2019 5:47:13 AM - Mar 18, 2019 5:47:00 AM  Mar 18, 2019 34721 AM ~ Mar 18, 2019 5:47:21 AM
1018  sales grid_order_invoice_async | [SIMCCESS| Mar 18 2019 5:47:11 AM ~ Mar 18 2019 5:47:00 AM  Mar 18, 2019 S:47:20 AM ~ Mar 18, 2010 5:47:20 AM
1024  sales_grid_order_invoice_async = [PENDING|  Mar 18 2019 5:47:11 AM | Mar 18, 2019 5:53:00 AM
1025  sales grid_order_invoice_async = [PENDING | Mar 18, 2019 5:47:11 AM | Mar 18, 2019 5:54:00 AM

APl Methods

APl methods allow admin to connect quote requests and proposals to and from other systems such as
ERP and CRM.

The following methods are available:
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amastyRequestQuoteRem arkServiceV1 nedace RemarkServicelnterface A

fV1l/amasty_quote/updateRemark

amastyRequestQuoteQuoteRepositoryV1 e
/V1l/amasty_quote/approve/{quoteld}
/Vl/amasty_quote/expire/{quoteld}

m fV1/amasty_quote/search

/V1l/amasty_quote/quote/note/customer:quoteld

/V1l/amasty quote/quote/note/admin:quoteld

amastyRequestQuoteQuoteltemRe pgsitu ryV1 inerface QuotentemRepositoryinterface A
/Vl/amasty_quote/quote_item/note/customer:quoteld

/V1l/amasty_quote/quote_item/note/admin:quoteld
Using API methods, you can Get Quote, Approve Quote, Expire Quote, Add Quote Comment
and Add Quote Item Note.
PUT request - to update a particular quote;

GET request - to retrieve data from a server.

Find out how to install the Request a Quote for Magento 2 via Composer.

From:
https://stg.amasty.net/docs/ - Amasty Extensions FAQ

Permanent link: (2]
https://stg.amasty.net/docs/doku.php?id=magento_2:request_a_quote

Last update: 2021/03/23 10:38
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